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Introduction 
This style guide is designed to assist in the creation of user manuals, 
specifications, narratives, testing and training guides and system manuals. 

General Conventions 
Table 1. Conventions Table 

Convention Details 
Branding/Logo Use the [Company Logo] at the top left corner 

of each page 
Applications [Proprietary Naming] 
Documentation Software Microsoft Word 
Cover Page – Software Design 
Specification (SDS) and 
Software Requirements 
Specification (SRS) 

3pt Top Border, Solid Black 0pt above logo 
[US Company of Engineers logo]  
10pts after logo 
Main Title: Arial, 40pt font, 20pts after Main 
Title 
Subtitle: Arial, 32pt font, 20pts after Subtitle 
Build Title: Arial, 24pt font, 20pts after Build 
Title 
Version & Current Date: Arial, 18pt font, no 
space between Version and Current Date 
No Page Number or Header/Footer on Cover 
page  

Cover Page – User Manual, 
Training Guide, System 
Manual 

Includes Company logo (150pt x 150pt) 
- Company Name – Centered, Underlined 

(Tahoma, 36pt, Bold) 
- Name of Document (Tahoma, 24pt, Bold) 
- Original Date – Left justified (Tahoma, 

14pt) 
- Revision Date – Left justified (Tahoma, 

14pt) 
Document Control (Version 
Control) 

Table includes: Date, Version Number (#) 
Author, Section,  Revision, Description 
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Convention Details 
 
 
 
Document Change Approvers 

Revisions include Draft, Preliminary Review, 
Final Review and Final. 
 
Table includes Function and Name headings. 

Table of Contents Use standard Table of Contents: 
Reference > Table of Contents > Insert 
Table of Contents 

 
Table of Tables 
Table of Figures 

Reference > Caption group > Insert Table 
of Figures 

• Select Figure for Table of Figures. 
• Select Table for Table of Tables. 
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Convention Details 

 
Printed Documentation All printed documents will have a cover page,  

revision history, and table of contents 
Margins Standard Portrait and Landscape Margins 

Top/Bottom 1 inch 
Left/Right 1 inch 
Header from top .5 inch 
Footer from bottom .5 inch 

Hyperlinks Use standard hyperlink blue: blue text with 
underline for PDF and printed materials.  

Text Normal - Times New Roman, 12pt 
Italics/Bold Use italics sparingly, bold is preferred in a 

User Manual to emphasize an action, field or 
screen name in a process step: 

Click the Option button to open 
the Project window. 
 

See Table 2 on page 7 for 
additional details. 

Paragraphs Never indent, align left and separate 
paragraphs by two line breaks. 

http://www.pinterest.com/
http://www.pinterest.com/
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Convention Details 
Spelling Outgrant as opposed to “out-grant” or “out 

grant” 
Login screen 
Users “log in” 
“drop down” menu or “drop down” list 
“user name” instead of “username”  
“Requester” not “Requestor” 
“Shall” not “will” 
“Enter” not “record” 
“Reports” not “live reports” 
“list of values” not “valid list of values” 
“Capture” not “capture and track” 
“email notification” not “message” 
“tracts” not “land tracts” 

Section/Page Breaks General Page Break: 
Insert > Page Break 
 
Section Break: 
Page Layout > Breaks  drop down > Next 
Page 

Table Setup Headings are 12pt font, Times New Roman  
Cells are 11pt font, Times New Roman 
Caption is 11pts font, Times New Roman, Bold 
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Microsoft Word Styles 
Table 2. Styles Table 

Style Use and Setup 
Heading 1 Use: Main topics such as Introduction, Overview and 

application titles; includes a numeric Chapter Number (1, 
2, etc.) 
Style: Font – Times New Roman, 18pts. Bold 

Heading 2 Use: Secondary headings such as main screens within an 
application or main processes, includes a numeric Chapter 
Number (1.1, 1.2, etc.) 
Style: Font – Times New Roman, 16pts. Bold 

Heading 3 Use: Third heading level, includes a numeric Chapter 
Number (1.1.1, 1.2.3, etc.) 
Style: Font – Times New Roman, 14pts. Bold 

Heading 4 Use: Fourth heading level, includes a numeric Chapter 
Number (1.1.1.1, 1.2.3.4, etc.) 
Style: Font – Times New Roman, 13pts. Bold 

Heading 5 Use: Fifth heading level, includes a numeric Chapter 
Number (1.1.1.1.1, 1.2.3.4.5, etc.) 
Style: Font – Times New Roman, 12pts. Bold and Italics 

Normal or Plain 
Text 

Use: Main text, follows all headings 
Style: Font – Times New Roman, 12pts. 

Process Steps Use: Details the action needed to complete the application 
Built-in Word numbering system. 

1. Process 1. 
2. Process 2. 
3. Process 3. 

Sub-processes use a, b, c, etc. 
a. Process 1a. 
b. Process 1b. 

List Bullets Use: Highlights items of importance or may be used with 
processes below sub-processes. 

Note(s) Use: Adding information related to the process steps. 
Note:  
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Style Use and Setup 
[need to add a table] 
 

Alerts/Warnings Use: Shows the user that a specific action may result in 
deletion or other system issue if the process is not 
followed. 

 ALERT! 
 STOP! 

Field Definitions Screen components used to describe information needed 
to complete an action in a User Manual.  

Headers & Footers 
(Printed Materials) 

SRS 
Header:  
Top Left – Company 1 logo  
Top Right –  

Application Name, Build, Phase, Document Type  
(Example: Software Build 7 Data Dictionary) 
Version, Status 
Date 

 

Footer: 
Bottom Left – Application Name and Build Number 
Bottom Right – Page Number 
 
SDS 
Header:  
Top Left – Company 2 logo  
Top Right –  

Application Name, Build and Phase  
Document Type 
Version, Status 
Date 

 

Footer: 
Bottom Left – Application Name and Build Number 
Bottom Right – Page Number 
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Style Use and Setup 
 
User Guide, System Manual 
TBD 
 
Training Guide 
TBD 

Icons If icons exist in the applications that need to be detailed, 
a table will be created to define each icon used.  
 

Example:  
Icon Action  Definition 

 Select drop down to show 
calendar 

Allows the user to select a 
specific date from a calendar. 
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Style Use and Setup 
Captions Captions are used for Figures and Tables (see Figures and 

Tables sections for details) 
To create a new caption:  
Reference group > Insert Caption > Select Label 
(Table, Figure) > Select Position  

Note:  Select Above Selected Item for Table  
and  
Select Below Selected Item for Figure 

 
Click Numbering on the Caption window to open the 
Caption Numbering dialog box. 

 
Use the default format.  
Select the Include chapter number box. 
Click OK to save changes. 
Captions have spacing of 6pts above and 0pts below 
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Screen Captures 
Currently we are using Snipping Tool and Paint.  

Capturing Screens 
1. Open the image to be captured.  
2. Click the Snipping Tool icon and capture the image. 
3. Select File and Save As. The Save As dialog displays.  
4. Name the file in the File name: field and click Save.  

Note: Create an image folder to save specific images or use the Pictures file 
Microsoft provides by default.  

5. Once saved, open the MSPaint application.  
6. In MSPaint, click File then Open and select the folder where the image is 

saved. 
7. The image opens in MSPaint. Callouts, text boxes and adjustments can be 

made to the image.  

Note: Snipping Tool has a few callout features like the Pen  and Highlighter

. It also allows the callouts to be erased using the Erase tool .  

 
Figure 1 – Snipping Tool 
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Captions  
Captions are for Tables and Figures. See Caption section of Table 2 for the 
process. 

Figures  
For figures, add the image to the document (see the Screen Captures section on 
page 11 for processes). 
Images are formatted as follows: 

Font:   Times New Roman, 11pts. 
Spacing:   Centered between text 
Above:   6pts 
Below:   0pts 
Picture Border: ¼ point 
Figure Caption:  Above 0pts. 
   Below 12pts. 

 
Figure 2 – Beach Picture 
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Process Steps for Figures 
1. Insert the image to the document. 
2. Select the image and click the Center icon on the Paragraph group. 

 
Figure 3 – Centered Image 

3. Double-click the image to open the Picture Tools.  
a. Select Picture Border. 
b. Click ¼ pt. _________ to add a thin border around the image. 

 
Figure 4 – Format Picture Tools 

4. Adjust the spacing above and below the image.  
a. Select the image. 
b. Click Page Layout. 
c. Select Spacing in the Paragraph group. 

 

 
Figure 5 – Image Spacing 
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5. Add a figure caption (See Caption section of Table 2. Styles Table) and 
add the spacing for the figure below the image (see Step 4 above). The 
figure captions should include the Heading chapter number with the figure 
number (Figure 1-1). 

6. To adjust an image without using the mouse: 
a. Select the image to open Picture Tools. 
b. Click the up and down arrows to adjust the Height and Width of the 

image.  

 
Figure 6 – Image Spacing 

Note: When using callouts (a square or circle identifying an illustration or 
a specific part of one), use a red outlined square unless the background is 
red then use a blue outlined square.  

Tables 
To insert a table, follow the steps below. 

1. Click the Insert tab and click the Table icon.  
2. Select the number of columns and rows needed for the table when the 

table drop-down opens. The table displays on the page (see Table 3. 
Example Table below). 
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Figure 7 – Image Spacing 

Note: Table captions should be placed above the table while figure captions are 
placed below the image. 
Tables are formatted as follows: 

Font:   (Heading) Times New Roman, 12pts. Bold 
   (Cells) Times New Roman, 11pts.  

(Caption) Times New Roman, 11pts. Bold 
Spacing:   Left Margin 
Above:   3pts 
Below:   3pts 
Table Caption:  Above 6pts. 
   Below 0pts. 

Table 3. Example Table 
Screen Field Description 
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If the table is long and will cross pages, select the table and right-click then 
select Table Properties. Click the Row tab and under Options, select Repeat 
as header row at the top of each page.  

 
Figure 8 – Table Properties 
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Table formatting is simple - Top row is light gray and column headers are Times 
New Roman, 12pt. Bold.  

1. Select the top row to shade that row. 
2. While row is selected, right-click and select Borders and Shading. 
3. Click the Shading tab 
4. Under the Fill section, select the second gray color  
5. Click OK.  

Note: Verify that Apply to: Cell is selected in the Preview drop down. 

 
Figure 9 – Image Spacing 
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Cross-References 
Cross-references allow the writer to create documentation once and refer the 
user to that section with adding page count to the guides or specifications. The 
cross-reference most often used will be See [table, figure] below or See [table, 
figure, or section] on page [xyz]. 
 

To create a cross reference, follow the steps below.  
1. Select Reference. 
2. Click Cross Reference from the Captions group. The Cross-Reference 

dialog displays. 
3. Select Reference Type. 
4. Click the arrow and select Insert reference to: 
5. Verify that the Insert as hyperlink is checked. 
6. Select the reference type from the For which caption: box. 

 
Note: When using cross-references that use the captions or text, make the 
content italics. Ex: “see the Screen Captures section on page 11 for processes.” 
 

 
Figure 10 – Cross-Reference 



Page 19 
 

Table 4. Cross-Reference 
Reference 

Type 
Insert reference 

to: 
Situation 

Numbered 
Item 

Page Number, 
Paragraph Number 

Use the page number for 
statements: “See page 7 for the 
process step for Process 1.”  
 

User the paragraph number for 
statements: “See Step 1 for 
additional details on Process 1.” 
 

These two references can be used 
together.  

Heading Heading Text or Page 
Number 

Use Heading text and page number 
together.  
“The General Conventions will show 
general document needs.” 
“The General Conventions on page 3 
shows the conventions most often 
used in a document.” 

Figure Entire Caption, Page 
Number 

When referring to figure, use the 
entire caption (Figure 2 – Beach 
Picture) to add specific details.  
Or refer the user to the page with 
the figure. “See page 12 for an 
image of the beach.”  

Table Entire Caption, Only 
label and number, 
Page Number 

When referring to table, use the 
entire caption (Table 2. Styles Table) 
to add specific details.  
Or refer the user to the page with 
the figure. “See page 19 for details 
on creating cross-references.” 
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